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Notice

Every effort was made to ensure that the information in this document
was complete and accurate at the time of printing. However,
information is subject to change.

Warranty

Avaya Inc. provides alimited warranty on this product. Refer to your
sales agreement to establish the terms of the limited warranty. In
addition, Avaya's standard warranty language as well asinformation
regarding support for this product, while under warranty, is available
through the following Web site: http://www.avaya.com/support.

Preventing Toll Fraud

“Toll fraud” isthe unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there may be arisk of toll fraud
associated with your system and that, if toll fraud occurs, it can result
in substantial additional chargesfor your telecommunications
services.

Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need
technical assistance or support, in the United States and Canada, call
the Technical Service Center's Toll Fraud Intervention Hotline at
1-800-643-2353.

How to Get Help

For additional support telephone numbers, go to the Avaya support
Web site: http://www.avaya.com/support. If you are:

» Within the United States, click the Escalation Management link.
Then click the appropriate link for the type of support you need.

» Outside the United States, click the Escalation Management link.
Then click the International Services link that includes telephone
numbers for the international Centers of Excellence.

Providing Telecommunications Security

Telecommunications security (of voice, data, and/or video
communications) is the prevention of any type of intrusion to (that is,
either unauthorized or malicious access to or use of) your company's
telecommunications equipment by some party.

Your company's “telecommunications equipment” includes both this
Avaya product and any other voice/data/video equipment that could be
accessed via this Avaya product (that is, “networked equipment”).

An “outside party” is anyone who is not a corporate employee, agent,
subcontractor, or is not working on your company's behalf. Whereas, a
“malicious party” is anyone (including someone who may be
otherwise authorized) who accesses your telecommunications
equipment with either malicious or mischievous intent.

Such intrusions may be either to/through synchronous (time-
multiplexed and/or circuit-based) or asynchronous (character-,
message-, or packet-based) equipment or interfaces for reasons of:

« Utilization (of capabilities special to the accessed eguipment)

» Theft (such as, of intellectual property, financial assets, or toll
facility access)

 Eavesdropping (privacy invasions to humans)

» Mischief (troubling, but apparently innocuous, tampering)

» Harm (such as harmful tampering, data loss or alteration,
regardless of motive or intent)

Be aware that there may be arisk of unauthorized intrusions
associated with your system and/or its networked equipment. Also
realize that, if such an intrusion should occur, it could result in a
variety of losses to your company (including but not limited to,
human/data privacy, intellectual property, material assets, financial
resources, labor costs, and/or legal costs).

Responsibility for Your Company’s Telecommunications Security

The final responsibility for securing both this system and its
networked equipment rests with you - Avaya's customer system
administrator, your telecommunications peers, and your managers.
Base the fulfillment of your responsibility on acquired knowledge and
resources from a variety of sources including but not limited to:

« |nstallation documents

¢ System administration documents

¢ Security documents

» Hardware-/software-based security tools

« Shared information between you and your peers
« Telecommunications security experts

To prevent intrusions to your telecommuni cations equipment, you and
your peers should carefully program and configure:

« Your Avaya-provided telecommunications systems and their
interfaces

« Your Avaya-provided software applications, as well as their
underlying hardware/software platforms and interfaces

« Any other equipment networked to your Avaya products

TCP/IP Facilities

Customers may experience differencesin product performance,
reliability and security depending upon network configurations/design
and topologies, even when the product performs as warranted.

Standards Compliance

Avaya lnc. is not responsible for any radio or television interference
caused by unauthorized modifications of this equipment or the
substitution or attachment of connecting cables and equipment other
than those specified by Avaya Inc. The correction of interference
caused by such unauthorized modifications, substitution or attachment
will bethe responsibility of the user. Pursuant to Part 15 of the Federal
Communications Commission (FCC) Rules, the user is cautioned that
changes or modifications not expressly approved by Avaya Inc. could
void the user’s authority to operate this equi pment.

Product Safety Standards

This product complies with and conforms to the following
internationa Product Safety standards as applicable:

Safety of Information Technology Equipment, IEC 60950, 3rd Edition
including all relevant national deviations as listed in Compliance with
IEC for Electrical Equipment (IECEE) CB-96A.

Safety of Information Technology Equipment, CAN/CSA-C22.2
No. 60950-00 / UL 60950, 3rd Edition

Safety Reguirements for Customer Equipment, ACA Technical
Standard (TS) 001 - 1997

One or more of the following Mexican nationa standards, as
applicable: NOM 001 SCFI 1993, NOM SCFI 016 1993, NOM 019
SCFI 1998

The equipment described in this document may contain Class 1
LASER Device(s). These devices comply with the following
standards:

« EN 60825-1, Edition 1.1, 1998-01
* 21 CFR 1040.10 and CFR 1040.11.


http://www.avaya.com/support
http://www.avaya.com/support/

The LASER devices operate within the following parameters:

* Maximum power output: -5 dBm to -8 dBm
» Center Wavelength: 1310 nm to 1360 nm

Luokan 1 Laserlaite
Klass 1 Laser Apparat

Use of controls or adjustments or performance of procedures other
than those specified herein may result in hazardous radiation
exposures. Contact your Avaya representative for more laser product
information.

Electromagnetic Compatibility (EM C) Standards

This product complies with and conforms to the following
international EMC standards and all relevant national deviations:

Limits and Methods of Measurement of Radio Interference of
Information Technology Equipment, CISPR 22:1997 and
EN55022:1998.

Information Technology Equipment — Immunity Characteristics —
Limits and Methods of Measurement, CISPR 24:1997 and
EN55024:1998, including:

* Electrostatic Discharge (ESD) IEC 61000-4-2

» Radiated Immunity |EC 61000-4-3

* Electrical Fast Transient IEC 61000-4-4
Lightning Effects |EC 61000-4-5

Conducted Immunity |EC 61000-4-6

* Mains Freguency Magnetic Field IEC 61000-4-8
* Voltage Dips and Variations |[EC 61000-4-11

* Powerline Harmonics |EC 61000-3-2

Voltage Fluctuations and Flicker |[EC 61000-3-3

Federal Communications Commission Statement

Part 15:

Note: Thisequipment has been tested and found to comply with
thelimitsfor a Class A digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable
protection against harmful inter ference when the equipment is
loper ated in acommercial environment. Thisequipment gener ates,
uses, and can radiate radio frequency energy and, if not installed
iand used in accor dance with the instruction manual, may cause
har mful interference to radio communications. Operation of this
lequipment in aresidential areaislikely to cause harmful
interference in which case the user will berequired to correct the
interference at his own expense.

Part 68: Answer-Supervision Signaling

Allowing this equipment to be operated in a manner that does not
provide proper answer-supervision signaling isin violation of Part 68
rules. This equipment returns answer-supervision signals to the public
switched network when:

» answered by the called station,

» answered by the attendant, or

« routed to arecorded announcement that can be administered by
the customer premises equipment (CPE) user.

This equipment returns answer-supervision signals on all direct
inward dialed (DID) calls forwarded back to the public switched
telephone network. Permissible exceptions are:

e A call isunanswered.
* A busy toneisreceived.
* A reorder toneis received.

Avaya attests that this registered equipment is capable of providing
users accessto interstate providers of operator servicesthrough the use
of access codes. Modification of this equipment by call aggregatorsto
block access dialing codes is aviolation of the Telephone Operator
Consumers Act of 1990.

REN Number
For MCC1, SCC1, CMC1, G600, and G650 M edia Gateways:

This equipment complieswith Part 68 of the FCC rules. On either the
rear or inside the front cover of this equipment is alabel that contains,
among other information, the FCC registration number, and ringer
equivalence number (REN) for this equipment. If requested, this
information must be provided to the telephone company.

For G350 and G700 M edia Gateways:

This equipment complies with Part 68 of the FCC rules and the
requirements adopted by the ACTA. On the rear of thisequipmentisa
label that contains, among other information, a product identifier in
the format USSAAAEQ##TX XX X. The digits represented by ## are
the ringer equivalence number (REN) without a decimal point (for
example, 03 isa REN of 0.3). If requested, this number must be
provided to the telephone company.

For all media gateways:

The REN is used to determine the quantity of devicesthat may be
connected to the telephone line. Excessive RENs on the telephone line
may result in devices not ringing in response to an incoming call. In
most, but not all areas, the sum of RENs should not exceed 5.0. To be
certain of the number of devices that may be connected to aline, as
determined by the total RENs, contact the local telephone company.

REN is not required for some types of analog or digital facilities.

M eans of Connection

Connection of this equipment to the telephone network is shown in the
following tables.

For MCC1, SCC1, CMC1, G600, and G650 M edia Gateways:

Manufacturer’s Port FIC Code SOC/REN/ Network
Identifier A.S.Code Jacks
Off premises station OL13C 9.0F RJ2GX,
RJ21X,
RJ11C
DID trunk 02RV2-T 0.0B RJ2GX,
RJ21X
CO trunk 02GSs2 0.3A RJ21X
02LS2 0.3A RJ21X
Tietrunk TL31IM 9.0F RJ2GX
Basic Rate Interface 0215 6.0F, 6.0Y RM9C
1.544 digita interface 04DU9-BN  6.0F RJ8C,
RJ8M
04DU9-IKN  6.0F RM8C,
RJ48M
04DU9-ISN  6.0F RJM8C,
RJ48M
120A4 channel serviceunit  04DU9-DN  6.0Y RJ8C



For G350 and G700 M edia Gateways:

Manufacturer’s Port FIC Code  SOC/REN/ Network
Identifier A.S.Code Jacks
Ground Start CO trunk 02GS2 1.0A RJ11C
DID trunk 02RV2-T ASO RJ11C
Loop Start CO trunk 02LS2 0.5A RJ11C
1.544 digital interface 04DU9-BN  6.0Y RM8C
04DU9-DN  6.0Y RM8C
04DUY-IKN  6.0Y RM8C
04DU9-ISN  6.0Y RM8C
Basic Rate Interface 02I1S5 6.0F RJ49C

For all media gateways:

If the terminal equipment (for example, the media server or media
gateway) causes harm to the tel ephone network, the telephone
company will notify you in advance that temporary discontinuance of
service may be reguired. But if advance noticeis not practical, the
telephone company will notify the customer as soon as possible. Also,
you will be advised of your right to file a complaint with the FCC if
you believeit is necessary.

The telephone company may make changesin itsfacilities, equipment,
operations or procedures that could affect the operation of the
equipment. If this happens, the telephone company will provide
advance notice in order for you to make necessary modificationsto
maintain uninterrupted service.

If trouble is experienced with this equipment, for repair or warranty
information, please contact the Technical Service Center at
1-800-242- 2121 or contact your local Avaya representative. If the
equipment is causing harm to the telephone network, the telephone
company may request that you disconnect the equipment until the
problem is resolved.

A plug and jack used to connect this equipment to the premises wiring
and telephone network must comply with the applicable FCC Part 68
rules and requirements adopted by the ACTA. A compliant telephone
cord and modular plug is provided with this product. It is designed to
be connected to a compatible modular jack that is also compliant. Itis
recommended that repairs be performed by Avaya certified
technicians.

The equipment cannot be used on public coin phone service provided
by the tel ephone company. Connection to party line service is subject
to state tariffs. Contact the state public utility commission, public
service commission or corporation commission for information.

This equipment, if it uses atelephone receiver, is hearing aid
compatible.

Canadian Department of Communications (DOC) Interference
Information

This Class A digital apparatus complies with Canadian | CES-003.

Cet appareil numérique delaclasse A est conforme alanorme
NMB-003 du Canada.

This equipment meets the applicable Industry Canada Terminal
Equipment Technical Specifications. Thisis confirmed by the
registration number. The abbreviation, I1C, before the registration
number signifies that registration was performed based on a
Declaration of Conformity indicating that Industry Canada technical
specifications were met. It does not imply that Industry Canada
approved the equipment.

Declar ations of Conformity

United States FCC Part 68 Supplier’s Declaration of Conformity
(SDoC)

Avayalnc. in the United States of America hereby certifies that the
equipment described in this document and bearing a TIA TSB-168
label identification number complies with the FCC’s Rules and
Regulations 47 CFR Part 68, and the Administrative Council on
Terminal Attachments (ACTA) adopted technica criteria.

Avaya further asserts that Avaya handset-equipped terminal
equipment described in this document complies with Paragraph
68.316 of the FCC Rules and Regulations defining Hearing Aid
Compeatibility and is deemed compatible with hearing aids.

Copies of SDoCs signed by the Responsible Party in the U. S. can be
obtained by contacting your local sales representative and are
available on the following Web site: http://www.avaya.com/support.

All Avaya media servers and media gateways are compliant with FCC
Part 68, but many have been registered with the FCC before the SDoC
process was available. A list of all Avayaregistered products may be

found at: http://www.part68.org by conducting asearch using “ Avaya’
as manufacturer.

European Union Declar ations of Confor mity

&S

Avaya Inc. declares that the equipment specified in this document
bearing the “CE” (Conformité Europeénne) mark conformsto the
European Union Radio and Telecommunications Terminal Equipment
Directive (1999/5/EC), including the Electromagnetic Compatibility
Directive (89/336/EEC) and Low Voltage Directive (73/23/EEC). This
equipment has been certified to meet CTR3 Basic Rate I nterface (BRI)
and CTR4 Primary Rate Interface (PRI) and subsetsthereof in CTR12
and CTR13, as applicable.

Copies of these Declarations of Conformity (DoCs) can be obtained
by contacting your local sales representative and are available on the
following Web site: http://www.avaya.com/support.

Japan

ThisisaClass A product based on the standard of the Voluntary
Control Council for Interference by Information Technology
Equipment (VCCI). If this equipment is used in a domestic
environment, radio disturbance may occur, in which case, the user
may be required to take corrective actions.

CoER, ROUREESENEEN TRABES (VCCT) oKk
(CIESE 7 T AN BBEREER T, - ORE&FERICHMT S & Bl
BEES I T I BB 0 ET, OB ISR A A
LEOERENLZLRBHY ET,

To order copies of thisand other documents:

Cal: Avaya Publications Center
Voice 1.800.457.1235 or 1.207.866.6701
FAX 1.800.457.1764 or 1.207.626.7269

Write: Globalware Solutions

200 Ward Hill Avenue

Haverhill, MA 01835 USA

Attention: Avaya Account Management
E-mail:  totalware@gwsmail.com

For the most current versions of documentation, go to the Avaya
support Web site: http://www.avaya.com/support.
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Preface
Purpose

Preface

Purpose

This book explains how to configure Avaya Fault and Performance Manager (Fault and Performance
Manager).

Prerequisites

Configuring Fault and Performance Manager requires familiarity with network administration and
knowledge of the Red Hat Linux operating system. This knowledge is not delivered in this book but is
essentia for a successful installation.

For thisreason, we highly recommend that workstation or network administrators take the primary rolein
installation.

Intended Audience

We wrote this book for workstation or network administrators.

Conventions Used in This Book

In this book, we use the following typographical conventions:

* We use bold type for emphasis and for any information that you should type; for example: save
translation.

* We use Courier font for any information that the computer screen displays; for example: | ogi n.

* Weuse arrows to indicate options that you should select on cascading menus; for example:
“Select File>Open” means choose the “Open” option from the “File” menu.

Avaya Fault and Performance Manager Configuration 9
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Preface

Additional Resources

Additional Resources

You may find the following additional resources helpful.

For help using Fault and Performance Manager, see the Fault and Performance Manager online help. It
explains how to perform basic administration tasks. To access the online help, start Fault and
Performance Manager and choose Help>Help Topics.

For help with complex administration tasks, use the Administrator’s Guide for Avaya Communication
Manager, which explains system features and interactions in detail. You can access this document from
the Integrated Management home page.

Tell Us What You Think!

Let us know how this book measured up to your expectations. Your opinions are crucial to helping us
meet your needs! You can send us your comments by mail, fax, or e-mail, as follows:

Mail: Avaya, Inc.
Fault and Performance Manager Documentation Team
Room 3C-313
307 Middletown Lincroft Rd.
Lincroft, NJ07738
USA

Fax: Fault and Performance Manager Documentation Team
+ 1732 852-2469

E-mail: document@avaya.com

How to Get This Book (and Others) on the Web

10

You can view or download the latest version of this book from the Avaya, Inc. web site. You must have
access to the Internet, an Internet browser, and Adobe Acrobat Reader (version 5.0 or later) with Search.
Adobe Acrobat Reader is available from http://mmw.adobe.com.

To view or download the latest version of the Avaya I ntegrated Management documentation:
1  Access http://mww.avaya.convsupport.
2  Click Product Documentation.
3 Click System and Network Management.
4

Locate the heading “ Avaya Integrated Management,” and click the link corresponding to the
software release.

5  Locate thetitle of the book, and click the link corresponding to the book.

Avaya Fault and Performance Manager Configuration
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Preface
How to Order More Copies of This Book

How to Order More Copies of This Book

To order paper copies of this book, call or write us and request the following publication:

Order: Document Number:555-233-138
Issue:lssue 6
Date: July 2004

Call: Avaya Publications Center
Voice:1 800 457 1235

Fax: 1800457 1764
If you are calling from somewhere that cannot access US 1-800 numbers, then call:

Voice:+ 1 207 866 6701
Fax: + 1207 626 7269

Write: Globaware Solutions
200 Ward Hill Avenue
Haverhill, MA 01835
USA

Avaya Fault and Performance Manager Configuration 11
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Resources and Notices
Avaya Technology and Consulting (ATAC)

1 Resources and Notices

Avaya provides avariety of planning, consulting, and technical services. The sections below briefly
describe the resources and services that are available.

Client executives are your primary contact to obtain information and explore options to meet your
specific business needs.

Avaya Technology and Consulting (ATAC)

ATAC works with client teams to develop detail ed solutions for connectivity to Communication Manager
Feature Servers. The ATAC aso designs network configurations to support Fault and Performance
Manager, Avaya Proxy Agent (Proxy Agent), and Avaya Sub-Agent.

Avaya Remote Network Integration Services (RNIS)

For this product, RNIS offers customers the following services:
¢ Verify platform readiness
¢ Remotely install Fault and Performance Manager

¢ Configure the network management server for each voice system to be managed by Fault and
Performance Manager

* Verify customer acceptance
* Custom on-site services

Avaya Technical Service Organization (TSO)

The TSO provides support for Fault and Performance Manager, Proxy Agent, and Sub-Agent to client
teams, field technicians, and customers. The TSO will bill customers for support on atime and materials
basisif the following conditions exist:

¢ Customers do not have a current maintenance agreement

¢ Customersdo not procure and install the required systems and software as defined in the
Integrated Management Services Support Plan

* Customers request support that is outside the purchase agreement

The TSO does not support hardware or software that customers purchase from third-party vendors.

Avaya Fault and Performance Manager Configuration 13
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Resources and Notices
Avaya Network Management Software Systems Support Group (NMSSS)

Avaya Network Management Software Systems
Support Group (NMSSS)

The Network Management Software Systems Support (NM SSS) group in Tampa Bay, Florida answers
customer calls about applications in Avaya Integrated Management. NM SSS will either answer your
questions directly or connect you with an associate who can answer questions about your application.

Avaya Contact Information

You may find the following contact information helpful at various times during the process of installing
and setting up this product This information was accurate at the time this book went to press. We update
thisinformation with each new release of Fault and Performance Manager.

Customers can access only the resourcesin Table 1 (not Table 2). To view Avayaweb sites, Avaya
recommends that you use Internet Explorer.

Table 1: Customer-Accessible Resources

Resource Contact Information

Avaya Support Center http://avaya.com/support/

Network Management 1-800-237-0016.

Software Systems Support

group

Remote Network Integration http://www1.avaya.com/enterprise/brochures/svcl1369.pdf
Services (RNIS)

Toll Fraud Intervention 1-800-643-2353 prompt 1

Table 2: Avaya Internal Resources

Resource Contact Information

Avaya Enterprise http://aem-support.dr.avaya.com/
Management Support

Avaya Technology and Phone: 1-888-297-4700, prompt 2, 6
Consulting (ATAC)

Main site (requires a password):
http://forum.avaya.com

1of2
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Resources and Notices
Third-Party Resources

Table 2: Avaya Internal Resources

Resource

Contact Information

Remote Network Integration
Services (RNIS)

Integrated Management
Services Support Plan

AIMO001 Form

http://associate2.avaya.com/sales market/products/data-
implementation-services/

http://associate2.avaya.com/sol ution/support_plans/
#Enterprise

http://associate2.avaya.com/sales market/products/data
implementation-services/

Then click “ Avaya Integrated Management Configuration
Request Form #1.”

20of2
Third-Party Resources
The table below lists contact information for third-party vendors.
Table 3: Vendor web sites
Vendor Web Sites
Hewlett-Packard Main site; http://www.openview.hp.com
Microsoft Main site; http://www.microsoft.com
Red Hat Linux Main site; http://www.redhat.com
Remedy Main site: http://www.remedy.com
Scroll down to: action request system
Vytek Main site: http://www.vytek.com
PostgreS Main site: http://www.postgresgl.com
Avaya Fault and Performance Manager Configuration 15
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Resources and Notices
System Security Notices

System Security Notices

Customers are solely responsible for the security of their system, network, and access to hardware and
software. The sections below define the precautions that all customers should take to maintain the
security of their systems.

Network Security

Fault and Performance Manager uses the standard security features on the Red Hat Linux, Windows
2000, Windows XP Professional, and Windows 2003 operating systems.

Avaya strongly recommends that customers use passwords to prohibit access to their systems and to
routinely change those passwords to maintain security.

A\ SECURITY ALERT:
Customers should always change passwords immediately after external vendors have
completed installation, maintenance, troubleshooting, or other tasks on their system.

Toll Fraud Security

Although Fault and Performance Manager is generally not at risk for toll fraud, customers are solely
responsible for the security of their entire telecommunications system.

Toll Fraud is the unauthorized use of a company’s telecommunications system by unauthorized parties.
Unauthorized parties are persons other than the company’s empl oyees, agents, subcontractors, or persons
working on behalf of the company. Toll fraud can result in substantial additional charges for the
company’s telecommuni cations services.

The company’s system manager is responsible for the security of the company’s system, which includes
programming and configuring the equipment to prevent unauthorized use.

Avaya Disclaimer
Avaya does not warrant that this product isimmune from or will prevent unauthorized use of common-

carrier telecommunications services or facilities accessed through or connected to it. Avayawill not be
responsible for any charges that result from such unauthorized use.

Toll Fraud Intervention

If customers suspect that they are a victims of toll fraud and need technical assistance, they should refer
to the phone number listed for Toll Fraud Intervention on page 14.
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Overview
Product Description

2 Overview

Avaya Fault and Performance Manager (Fault and Performance Manager or FPM), Avaya Proxy Agent
(Proxy Agent or PA), and Avaya Communication Manager Sub-Agent (Sub Agent or CMSA) provide a
complete solution to fault and performance management of Avaya voice elementsin both stand-alone
mode and in NM S integrated mode.

FPM, PA, and CM SA work with the Integrated M anagement Database (IMD) to keep information
together for al Integrated Management applications, to simplify data collection, to simplify data update,
and to ensure database consistency.

These products provide aview of the health and performance of your network systems. Fault and

Performance Manager, Proxy Agent, Sub-Agent, and Integrated Management Database work together as
an integrated application.

Product Description

Fault and Performance Manager provides graphical and tabular tools to monitor the status and
performance of anetwork of supported systems and external devices.

Fault and Performance Manager collects configuration, fault, and performance data from DEFINITY
Proxy Agent or directly from an IP enabled voice system using OSSI, and then displays the data in text,
tables, and graphic formats.

The primary features of Fault and Performance Manager include:

¢ Graphical User Interface (GUI) -- The main window contains a navigation tree that lists al the
supported systems and displays a colored alert symbol that indicates highest exception level. You
can expand thelist to view all of the configuration components and specific alert symbolsfor each
component.

¢ Configuration -- You can view the configuration and administered properties of all supported
systems (managed nodes) in both a graphic view and atable view.

¢ Administration -- You define the system-wide parameters for the features bel ow:

— Data collection -- You define the parameters for the data to be collected from each
system, including the type of data, the schedule for collecting data, and the length of time
to store the data.

— Exception logging -- You define the conditions to og exceptions for performance
thresholds, faults, and system errors.

— Exception alerting -- You specify the alert levels for exceptions from each supported
system. Alert levels may include exceptions that are critical, major, minor, or warning.
The alert level and location of the exception appear in the main window as long as the
exception exists.
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Supported Systems

Report Manager -- You can define the parameters for individual reports for al or selected
systems. The report options include:

— Performance
— Configuration
— Exceptions

You can view the reports on screen in both the table and chart formats or direct the reportsto a
printer, HTML file, GIF file, or ASCII file.

Scheduled Reports -- You can schedule reports to run on a daily, weekly, or monthly basis, and
edit and delete schedul es as needed.

Supported Systems

Fault and Performance Manager Release 2.1 supports both SNMP V1 and V2c¢ get and set requests and
SNMP V1 aarm traps for the following systems:

DEFINITY® ECS Releases 9.5 through 10.x
Survivable Remote Processors (SRPs)

Multipoint Conferencing Unit (MCU) Release 7.2
Avaya G350 & G700 Media Gateways

Avaya Communication Manager (Linux) Release 2.1
Avaya Communication Manager Release 9.5 through 11
Converged Communications Server (CCS) Release 1.0.
Interactive Response (IR) Releases 1.0 through 1.2

Fault and Performance Manager treats SRPs and MCUs as Communication Manager Feature Servers.

Fault and Performance Manager Release 2.1 supports only alarm traps for the following systems:

18

DEFINITY AUDIX® Releases 3.1 through 4.0

INTUITY AUDIX® Release 5.1 (with or without the remote maintenance board)
INTUITY ™ AUDIX® on S8100 Media Server

INTUITY ™ AUDIX® LX Release 1.0 through 17.X

INTUITY ™ AUDIX® on Multimedia Messaging Platform Release 1.0 through 1.1
Call Management System (CMS) R3V 8.3 through R3V 11

S8100 Media Server INTUITY AUDIX

INTUITY ™ Interchange Release 5.1 through 5.4

CONVERSANT® Release 7.0 through 9.0

IA770 INTUITY AUDIX® Option for S8300 |CC Release 1.0 through 2.0
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System Requirements

Hardware

You should work with your Avaya client team to determine the hardware regquirements that meet your
business and performance specifications. Your client team has access to the | ntegrated Management
Services Support Plan, which contains the information they need to help you determine hardware
requirements in your situation. Your client team can download the package from the URL listed in Table
2, Avaya Internal Resources, on page 14.

Hardware Certification

Avaya requires that Fault and Performance Manager hardware must be Red Hat Enterprise Linux AS
R3.0 certified or Red Hat Enterprise Linux ES 3.0 or 2.1 certified. For the Red Hat URL, see Third-Party
Resources on page 15.

CAUTION:
Customers are solely responsible for upgrading their network platformsto meet the NMS
platform requirements for Fault and Performance Manager Release 2.1.

Software

Fault and Performance Manager Release 2.1 operates on:
* Red Hat Enterprise Linux ASR3.0
* Red Hat Enterprise Linux ESR3.0
* Red Hat Enterprise Linux ES 2.1 (upgrades only)

The optional NM S| component runs on:
*  Windows 2000 Server running HP OpenView 6.4 or 7.0.1
¢ Solaris 8.0 or 9.0 running HP OpenView 6.4 or 7.0.1
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Configuration Overview

The configuration process will follow the basic steps listed below:
1 During the software installation, perform one of the following steps:

— If Fault and Performance Manager runs with a Network Management System (NMS),
complete the procedures in Configuring Fault and Performance Manager to Integrate with

HP OpenView on page 21.

— If Fault and Performance Manager runs “standalone,” complete the proceduresin
Configuring Fault and Performance Manager for Stand-Alone Operation on page 24.

2  Complete the procedures in Administering Alarm Notification Services on page 30.

3 If you will be using SNMP traps, complete the procedures in Configuring SNMP Traps on page
37.

4 |If you will be running Fault and Performance Manager with an NM S, compl eteExecuting Auto-
Discovery on page 54.

5 If youwant to use Fault and Performance Manager to collect data, create and save report
definitions, and schedul e reports, complete the procedures in Starting the Administrative GUI on
page 48.
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3 Configuring Fault and Performance
Manager

This chapter explains how to configure Avaya Fault and Performance Manager during the software
installation.

If you areinstalling a stand-alone system, go to Configuring Fault and Performance Manager for Stand-
Alone Operation on page 24.

If you areinstalling the HP OpenView integrated version, go to Configuring Fault and Performance
Manager to Integrate with HP OpenView on page 21.

Configuring Fault and Performance Manager
to Integrate with HP OpenView

CAUTION:

To use the NM S| portion of the offer, before beginning the following configuration
process, you must have HP OpenView for Windows NT/2000 Version 6.4 or 7.0.1
installed and running. FPM is supported on Linux only.

NOTE:

To use the OpenView Web client, the user must properly install and configure an
appropriate web server (Apache, IS, etc.). HP OpenView documentation should be
consulted for information on setting up the web server and using OpenView Web.

NOTE:
To setup HP OpenView for System View, select the following options from within
OpenView:
— Map>Properties...>View> Show Connection Labels
— Map>Properties...>Status Propagation>
Propagate Most Critical

Complete the procedures below to configure Fault and Performance Manager to integrate with
HP OpenView.

During the installation, the system displays the prompt:
Do you want to reconfigure the Avaya Fault and Performance Manager 2.1 software [yes]
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Perform the following steps:

1

22

Typeyes and press ENTER.

The system displays the prompt:

Enter FPM server IP/FQDN: [ ]?

Type the IP address or fully qualified domain name (FQDN) of the FPM server, and press
ENTER.

The system displays the prompt:

Shutting down FPM Server services:

Configuring environment:

Avaya Fault and Performance Manager provides for the capability of a
distributed Data Coll ection Network of servers. This server is currently
configured as a Primary data collection server. There may only be 1
Primary collection server in a network of FPM servers, and any nunber of
Secondary data coll ection servers.

Configure this server as the Primary Data Coll ection Server [yes]?
Typeyesand pressENTER.
The system displays the message:

Avaya Fault and Performance Manager and Miulti-Site Adninistration (MSA)
may be | oaded on separate servers for scalability and | oad bal anci ng. The
Avaya Fault and Performance Manager servlet must know where the prinmary
MSA server is to allow System View | aunching of the MSA application.
Enter the IP address or fully qualified domain name (FQDN) of the Avaya
Multi-Site Administration server.

Enter MSA server IP Address or FQDN [ ]7?
Type the IP address or FQDN of the MSA server, and press ENTER.
The system displays the message:

Avaya Fault and Performance Manager requires a print comand to be
specified. This command will be used by the application when attenpting
to print reports to a printer. The keyword “%ile” can be used in the
print conmand to represent the tenporary filenane created for printing
purposes. |If “%rint” does not appear here, the filename will be appended
to the print command.

Pl ease enter a default print command to be used by the FPM applications
Enter printer conmand [ ]°?

Type the print command, and press ENTER.

The system displays the message:

Avaya Fault and Performance Manager can integrate with an HP QpenVi ew
Net wor k Node Manager system It provides for MiltiVantage System Vi ew
whi ch shows | ogi cal connectivity anongst MiltiVantage |P tel ephony
endpoi nts. Refer to the Avaya Fault and Perfornmance Manager docunentation
for nore informati on about the OpenView NVS I ntegration.

Do you want to integrate FPM with an HPOV System [yes]?
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Typeyesand press ENTER.
The system displays the message:

In order for this capability to work, information regarding the IP
connectivity with the OQpenVi ew server nust be established.

Enter the HPOV Server |P Address [ ]°?.
Type the IP address of the HPOV server, and press ENTER.
The system displays the message:

Avaya voice related objects will be placed on the HP OpenView nmaps. A
specific map can be identified as the repository for where the Avaya
objects will be placed. By default, HP OpenView s default nmap name is
“default”. If you use a different OpenView map, that nap nane needs to be
entered here. If you are not sure just accept the default setting.

Enter the HPOV Server Map Nane [defaul t]?
PressENTER.
The system displays the following messages:

Avaya Fault and Perfornmance Manager has been configured as a Prinmary Data
Col | ection Server.

| MDAddApp | nfo: FPM successful ly updated in | MD

Configuring FPM Java Environnent...

Configuring FPM NVSI Environnent...

Modi fyi ng FPM Properties in Wb Cient JARfile...

Bui | di ng environnent file...

Pl atform confi gurati on conpl ete.

Starting FPM Server services: [OK]

Once FPM is configured for HP OpenView, the system displays the following message:

Avaya Fault and Performance Manager software configurati on was
successful .
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Configuring Fault and Performance Manager for
Stand-Alone Operation

Complete the procedure below to configure Fault and Performance Manager for stand-al one operation.
Skip this section if you do not plan to run Fault and Performance Manager standalone.

During the installation, the system displays the prompt:
Do you want to reconfigure the Avaya Fault and Performance Manager 2.1 software [yes]
1 Typeyesand pressENTER.
The system displays the prompt:
Enter FPM server IP/FQDN: [ ]?

2  Typethe P address or fully qualified domain name (FQDN) of the FPM server, and press
ENTER.

The system displays the prompt:
Shutting down FPM Server services:
Configuring environment:

Avaya Fault and Performance Manager provides for the capability of a
distributed Data Coll ection Network of servers. This server is currently
configured as a Primary data collection server. There may only be 1
Primary coll ection server in a network of FPM servers, and any nunber of
Secondary data coll ection servers.

Configure this server as the Primary Data Coll ection Server [yes]?
3 Typeyesand pressENTER.
The system displays the message:

Avaya Fault and Performance Manager and Multi-Site Adninistration (MSA)
may be | oaded on separate servers for scalability and | oad bal anci ng. The
Avaya Fault and Performance Manager servlet must know where the prinmary
MSA server is to allow System View | aunching of the MSA application.
Enter the IP address or fully qualified domain nane (FQDN) of the Avaya
Multi-Site Administration server.

Enter MSA server IP Address or FQDN [ ]7?
4 TypethelP address or FQDN of the MSA server, and pressENTER.
The system displays the message:

Avaya Fault and Performance Manager requires a print comand to be
specified. This command will be used by the application when attenpting
to print reports to a printer. The keyword “%ile” can be used in the
print command to represent the tenporary filenane created for printing
purposes. If “Y%rint” does not appear here, the filenane will be appended
to the print command.

Pl ease enter a default print command to be used by the FPM applications
Enter printer conmand [ ]7?
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Type the print command, and press ENTER.
The system displays the message:

Avaya Fault and Performance Manager can integrate with an HP QpenVi ew
Net wor k Node Manager system It provides for MiltiVantage System View
whi ch shows | ogical connectivity anmpobngst MiltiVantage | P tel ephony
endpoi nts. Refer to the Avaya Fault and Perfornmance Manager docunentation
for nmore information about the OpenView NMS | ntegration.

Do you want to integrate FPMwith an HPOV System [yes]?
Typeno and pressENTER.
The system displays the following messages:

Avaya Fault and Perfornmance Manager has been configured as a Primary Data
Col | ection Server.

| MDAddApp | nfo: FPM successfully updated in | MD
Configuring FPM Java Environnent...

Configuring FPM NVSI Environnent...

Modi fyi ng FPM Properties in Wb Cient JARfile...
Bui | di ng environnent file...

Pl atform configurati on conpl ete.

Starting FPM Server services: [OK]

Once FPM is configured, the system displays the following message:

Avaya Fault and Performance Manager software configurati on was
successful .
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4 Customizing Fault and Performance
Manager

Introduction

Only the system administrator or root user should edit the files that allow you to customize Avaya Fault
and Performance Manager (Fault and Performance Manager).

Theinformation in this chapter allows system administrators to manage the options below:
*  Set up the Avaya Sub Agent on your Communication Manager.
¢ Control the NMSI polling of Proxy Agents
* Override the default location submaps that are administered on Proxy Agents

* Execute system commands to start and stop Fault and Performance Manager and to view the
system health status

* Execute database commands
¢ Edit system configuration files to customize Fault and Performance Manager
* Integrate third-party products for alarm notification

Setting up DEFINITY Proxy Agent

For instructions on setting up the Avaya Sub Agent on your Communication Manager, see the
Administrator’s Guide for Avaya Communication Manager, 555-233-506 Issue 6. The section istitled,
“SNMP Agents’ in Chapter 17, “Administering Media Servers.”
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System Commands

Start and Stop Commands

Fault and Performance Manager processes normally start from Linux inittab. The commandsin the table
below give the system administrator additional control of the Fault and Performance Manager processes.

Table 4: Start and Stop commands

Command Description

service mfpm-server stop Stops the Fault and Performance
Manager system and preventsit from
starting at system boot.

service mfpm-server start Starts a stopped Fault and Performance
Manager system and enablesit to start at
system boot.

service mfpm-server restart Stops and immediately restarts the Fault

and Performance Manager system.

System administrators can view alog of system startups and shutdowns from /var/avaya/mfpm/logs/
MsgLog_[0-30]. The default number of MsgLog filesis 30. You can change this value.

System Health Commands

The table below contains the system health commands.

Table 5: System Health commands

Command Description
service mfpm-server status Displays Fault and Performance
Manager system process status
/opt/avaya/mfpm/bin/mfpm gui Opens a graphical monitor of
process status
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Backing up the Database

Only the root user can execute the procedure to back up the database.

You can back up the database during installation or at any time after the product is installed.

Required materials

You will need the following materials and information:
* Root login and password
* File name or device name to back up the database

Procedure

Please refer to the Linux backup procedure in the Avaya Integrated Management Release 2.1 Advanced
Converged Management Installation and Upgrade.

Restoring the Database

Only the root user can execute the procedure to restore the database.

You can restore the database from the backup file or the archive device.

Required materials

You will need the following materials and information;
* Root login and password

* File name or device name to back up the database

Procedure

Please refer to the Linux restore procedure in the Avaya Integrated Management Release 2.1 Advanced
Converged Management Installation and Upgrade.
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Administering Alarm Notification Services

Fault and Performance Manager offers anotification feature that, when used with third-party applications
can (for example) page you when Fault and Performance Manager receives an alarm. Only a system
administrator or aroot user who knows Linux shell programming should perform this task.

Script directories

The /opt/avaya/lmfpm/bin directory contains the sample scripts listed below:
e DEFINITY_ARS
e AUDIX_ARS
* CMS ARS
* CONVERSANT_ARS

Alarm notification options

System administrators can choose to use the pager or email features in Fault and Performance Manager or
edit the scripts to enable third-party products such as:

o Vytek, TeleAlert
¢ Remedy, Action Request System (ARS)

CAUTION:
Customers are solely responsible for the purchase, installation, and maintenance of third-
party software products.
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Description of Alarm Notification Options

The tables below outline the alarm natification options that are available in Fault and Performance
Manager or from third-party vendors.

Fault and Performance Manager options

The table below contains the description of product options within Fault and Performance Manager.

Table 6: Fault and Performance Manager notification options

Option Description

CU Pager Pages the system administrator and sends a code that identifies
the type of alarm, alert, or error received from the managed
system.

Email Sends an email message to the specified address that contains

detailed information for the alarm, alert, or error received from
the managed system. Individual email addresses can be set by
voice system and by type of alert.

TeleAlert options

The table below contains the descriptions of the notification optionsin Vytek’s TeleAlert.

Table 7: Vytek notification options

Option

Description

Alpha Page

Voice Page

AUDIX

Pages the system administrator and sends a code that identifies
thetype alarm, alert, or error received from the managed system.

The alpha page also confirms that the system administrator
received the page. The page repeats until the system
administrator responds to the page.

Sends a voice page to the system administrator and sends a code
that identifies the type of alarm, alert, or error received from the
managed system.

Calls the system administrator’s AUDIX number and leaves a
voice message that contains the detailed information for the
alarm, alert, or error received from the managed system.
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Peregrine option

The table below describes the notification options in Peregrine’s ARS product. The sample script only

supports ticketing. The Peregrine product supports voice page and email notification.

Table 8: Peregrine notification option

Option Description

Ticket

Creates atrouble ticket that contains the historical information
for the alarm, alert, or error received from the managed system.

DEFINITY_ARS Script

32

FPM looks for the DEFINITY_ARS script when one of the following events occur:

FPM receives an alarm trap from the managed nodes listed below:
— Communication Manager Feature Servers

— MCU

FPM receives an exception event from Fault and Performance Manager for these managed nodes

Then the FPM calls the script and passes the values listed below to the alarm notification program. If a

value is not defined, then FPM assignsthe alarm the string “NULL_FIELD.”

Alarm notification values:

O© 0O NO Ul WN P
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System name

Error description

New status severity

Old status severity

Product 1D

Alarm sequence number

Alarming Port

M aintenance object name

On board fault

Type of darm

Alternate name for the device
Describes the external device
Product Identifier of external device
Building location of external device
Address of external device

Restart date time

Restart level

Restart carrier
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20
21
22
23
24
25
26
27

Restart craft demand
Restart escalated
Restart interchange
Restart unavailable
Restart cause
Restart speA release
Restart speB release
Restart speA update
Restart speB update

AUDIX_ARS Script

Customizing Fault and Performance Manager

Administering Alarm Notification Services

FPM looks for the AUDIX_ARS script when one of the following events occur:

FPM receives an alarm trap from the managed nodes listed below:

— DEFINITY AUDIX
— Intuity AUDIX
— Intuity Interchange

FPM receives an exception event from Fault and Performance Manager for these managed nodes

Then FPM calls the script and passes the values listed below to the alarm notification program. If avalue
is not defined, then FPM assigns the alarm the string “NULL_FIELD.”

Alarm notification values:

1

A WN

© 00 N O O

10
1
12
13
14
15

System name

Product ID

Alarm sequence number

Source of the alarm:
— DEFINITY (for DEFINITY AUDIX)
— Intuity Interchange

Error description

New status severity

Old status severity

Alarm location

Alarm date

Alarm time

Resource

Fault code

Module 1D

Event number

Count number
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CMS_ARS Script

FPM looks for the CMS_ARS script when one of the following events occur:

FPM receives an alarm trap from the Call Management System (CMYS)

FPM receives an exception event from Fault and Performance Manager for the CMS

Then FPM calls the script and passes the values listed below to the alarm notification program. If avalue
is not defined, then the MFPM assigns the alarm the string “NULL_FIELD.”

Alarm notification values:

1
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CONVERSANT_ARS Script

System name
Product ID

Alarm sequence
Error description
New status severity
Old status severity
Product type
Version

ID value

Number

Name

FPM looks for the CONVERSANT_ARS script when one of the following events occur:
FPM receives an alarm trap from the CONVERSANT system
FPM receives an exception event from Fault and Performance Manager for the CONVERSANT

system

Then FPM calls the script and passes the values listed bel ow to the alarm notification program. If avalue
is not defined, then FPM assigns the alarm the string “NULL_FIELD.”

Alarm notification values:

1

O© 0O NO Ol & WDN
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System name
Product 1D

alarm number
Error description
New status severity
Old status severity
Location

Date

Time
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1
12
13
14

Resource
Fault code
Module 1D
Event number
Count number
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5 Configuring SNMP Traps

Communication Manager 2.1 provides a method for sending traps to Avaya Fault and Performance
Manager. This chapter describes how to configure traps to be send to FPM.

Recommended Software Requirements

We recommend the following software reguirements for complete support and functionality:
* Avayalntegrated Management Release 2.1
¢ Avaya Communication Manager Release 2.1

Configuration Procedures

To configure traps for FPM, you must perform the following procedures:
1 Launch the Maintenance web interface (Procedure 1: L aunch the Maintenance Web Interface on

page 38).
2 Configure trap destinations (Procedure 2: Configure Trap Destinations on page 39).

Add nodes (for example, voice systems and adjuncts) you want to manage.
4  AddaDEFINITY Proxy Agent.

w
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Procedure 1: Launch the Maintenance Web Interface

To launch the Maintenance web interface:

1  From the Integrated Management Standard Management Solutions page, click Launch
Maintenance Web | nterface.

2l sv_porthos(Standard Management Solutions) - Microsoft Internet Explorer

File Edit View Favortes Tocls Help | o
Q@ oeck - () - (%] (2] | S semch Pt M Hede 62| (- D B

Address [] hps://135.9.1921 /egrbinunitied B \ Links >
Google~| =]| & seachweb - @G sie | ) | PRk 6 - Ehi2blcked {2 Auichl | [ Options -4

AVAyA Integrated Management =

Standard Management Solutions

Help Log Off

u Installation The Avaya™ Installation Wizard allows Launch Avaya™ Installation
you to quickly install your system, Wizard

Administration The Mative Configuration Manager Launch Native Configuration
allows you to administer this system Manager
using a graphically enhanced SAT
applet,
The Avaya™ Station Administration Launch Avaya™ Station
Wizard runs in your browser and lets Administration Wizard
you perform station maoves, adds, and
changes,

Maintenance The Maintenance Web Interface allows Launch Maintenance Web
You to maintain, troubleshoot, and Interface

configure the media server,
Upgrade The Upgrade Toal allows you to Launch Upgrade Tool

upgrade Looal Survivable Pracessars
and G700 and G350 Media Gateways,

2002 Avaya Inc. All Rights Reserved

|
|&]Done |18 [ memant 7
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Procedure 2: Configure Trap Destinations

To configure trap destinations:

1  From the Alarms heading located on the navigation frame, click SNMP Traps. The SNMP Traps
screen appears.

soft Internet E:
File Edit View Favortes Tools Help |

Dok = 0 - [x] (2] | ) semeh [ Feres @ s 21
Address [€] g //135.9.192 1cgitin/logged_in
Google~ | ]| 8 Seocniweh ~ @ ceacnnis | gl | PRk - Bhizbocked 2 cuiorl | B Optors B v 4

AVAYA Integrated Management

Maintenance Web Pages
Help  Exit This Server: [1] sv-porthos

[

Alarme w SNMP Traps
Current Alarms
SNMP Agents
SNMP Traps

Diagnostics

B co

The SNMP Traps page allows specification of the alarms to be sent as traps.

Restarts Current Settings

System Logs

If"“‘pe"at“"e""“““e Status IP address Notification SNMP Yersion C: ity / User Name ¥3 Security Model Authentication Password Privacy Password
e No destinations have been configured.

Netstat

Modem Test mm
Server
Status Summary
Process Status
shutdown Server
Server Date/Time
Software Version
Server Configuration
Configure Server
Restore Defaults
Eject CD-ROM
Server Upgrades
Install New Software
Make Upgrade Permanent
Boot Partition
Linux Migration
(Backup/Restore)
IPSI Firmware Upgrades
IPSI Yersion
Download IPSI Firmware
Download Status
Activate IPSI Upgrade
Activation Status
Data Backup/Restore
Backup Now
Backup Status
Schedule Backup
Backup Logs
View/Restore Data
Restore Status
Format PC Card
Security
Modem
FTP
License File
Authentication File
I

e
Tripwire Commands
Install Root Certificate
SSH Keys

Miscellaneous
Download Files

de Message File
Serial Numbers

S @ mtemet 7
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2  Click the Add button. The Add Trap Destination screen is displayed.

40

2l sv-porthos - Microsoft Internet Explorer

File Edit View Favorites Tools Help w

@ oeck - ) - [x] (2] [ D seaeh S retes @ Meds &1 - 2 5 ] B

Addre:;sE]https /#135.9192.1/egibin/logaed_in =] B 6o

Google~| ]| dgp Geachweh G CeahiGie | gk || PaseRak - Lh12 biocked 2] Aol | Options -

AVAyA Integrated Management
Maintenance Web Pages

Help Exit

Alarms
Current Alarms
SNMP Agents
SNMP Traps
Diagnostics
Restarts
System Logs
Temperature/¥oltage
Ping
Traceroute
Netstat
Modem Test
Server
Status Summary
Process Status
Shutdown Server
Server Date/Time
Software Yersion
Server Configuration
Configure Server
Restore Defaults
Eject CD-ROM
Server Upgrades
Install New Software
Make Upgrade Permanent
Boot Partition
Linux Migration
(Backup/Restore)
IPSI Firmware Upgrades
IPSI ¥ersion
Download IPSI Firmware
Download Status
Activate IPSI Upgrade
Activation Status
Data Backup/Restore
Backup Now
Backup Status
Schedule Backup
Backup Logs
view/Restore Data
Restore Status

License File
authentication File
Firewall
Tripwire
Tripwire Commands
Install Root Certificate
SSH Keys
Miscellaneous
Download Files
Unicode Message File
Serial Numbers

: Add Trap Destination

Fill-in IP address and provide data for one of the three SNMP versions.

¥ Check to enable this destination,

IP address: [123 | J45 |67 | [89

This Server: [1] sv-porthos

@' SNMP version 1

Community name: [public

' SNMP version 2c

Motification type: [trap ¥
Community name:

€' SNMP version 3
Hotification type: Im
username: [
security Model: [Nons 7]
Authentication Password: [ | Must be at least & characters
Privacy Password: [ | Must be at least & characters

|| 8 @ miemet 7

3 Check the box labeled Check to enable this destination and add the |P address of the Fault and
Performance Manager. (If you are using Fault and Performance Manager, you must add the using
Fault and Performance Manager | P address here.) Thisis where you setup the agent to distribute
the SNMP traps to the proper destination.

4 Click the option button for SNMP version 1 and enter the read_community_namein the
Community name field.

5  Scroll down and click the Add button to add to the list of destinations.

6  Repeat steps 3 through 5 for every Fault and Performance Manager | P address you are adding to
thelist of destinations. After adding each destination you will see the following screen.
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a gambit-icc - Microsoft Internet Explorer - Iﬁllﬂ

Ele Edit Wiew Favorites Tools Help |-
GBak + = - 7t ‘ Qsearch GFavorkes iMedia (4 ‘ E-S e
Address I@ https:)i135,9.70.151 /cgi-binflogged_in j @GD

Google - | || Bpsearchwen + @oeaisie | gb | PeRek - Bhitabiocked fE]nuorl | Pdoptions -

Automatically Fill in & form
AVAYA I—fntegrated Management
Maintenance Web Pages
Help Exit This Server: [1] gambit-icc

[ 5 SNMP Traps

Current alarms
SNMP Agents

The SHMP Traps page allows specification of the slarms to be sent as traps.

Diagnostics
Restarts Current Settings
System Logs

Eing SNMP C ity / User ¥3 Security Authentication Privacy
L';;te‘:t"”te Status IP address Notification Yersion  Name Model Password Password
Modem Test ¢ enabled 135,9.70.227 trap w1 public /A NSA i
Server
Status Summary ¢ enabled 135,9.70.226 trap vl public N/A N/A /A
Process Status ~
Shutdown Server
Server Date/Time

Software ¥ersion

Server Configuration  add  Help |
Configure Server
Restore Defaults
Eject CD-ROM

Server Upgrades
Install New Softmare
Make Upgrade Permanent
Boot Partition
Linux Migration
{Backup/Restore)

Data Backup /Restore
Backup Now
Backup History
Schedule Backup

enabled 135,942,125 trap vl public NSA NSA A

Backup Logs

YiewfRestore Data

Restore History
Security

Modem

FTP
License File
4 henticati

[T [Benens

NOTE:
We do not recommend configuring multiple FPM systems as a method of disaster
recovery.

If you want to add nodes that you want to manage, go to Procedure 3: Add Nodes on page 41.

If youwant to add aDEFINITY Proxy Agent, go to Procedure 4: Add aDEFINITY Proxy Agent R4.0 on
page 42.

Procedure 3: Add Nodes

To add nodes (for example, voices systems and adjuncts) that you want to manage, you must use the
Integrated Management Database (IMD). See the Avaya I ntegration Management Database Release 2.1
Configuration or the Integrated Management Database online help for information on how to add nodes.

To add aDEFINITY Proxy Agent, go to Procedure 4: Add a DEFINITY Proxy Agent R4.0 on page 42.
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Procedure 4. Add a DEFINITY Proxy Agent R4.0

NOTE:

You cannot add a DEFINITY Proxy Agent using the Avaya I ntegrated Management
Database (IMD). To add aDEFINITY Proxy Agent, you must perform the procedure in
this section.

To add a DEFINITY Proxy Agent R4.0 into FPM:
1 Logintothe Integrated Management Linux server asroot.
2 Perform one of the following steps:

— If you are using Gnome, select
Foot icon>Programs>Avaya>Fault and Performance Manager>Administration>Add
Proxy/DEFINITY Proxy Agent to Database>Fault and Performance Manager Add Native/
Proxy Agent.

— If you are using KDE, select
K icon>Programs>Avaya>Fault and Performance Manager>Administration>Add Proxy/
DEFINITY Proxy Agent to Database>Fault and Performance Manager Add Native/Proxy
Agent.

3 Enter the following information:
— IP address of the Proxy Agent
— Read community name
— Write community name
— System group

Thiswill allow the Proxy Agent to connect to the Fault and Performance Manager application.
The following will occur:

— Anentry will be added to the Fault and Performance Manager database.
— Anicon will be created on the Fault and Performance Manager tree.

— The configuration information will be updated.
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Enter Proxy Agent information:

Proxy Agent: 12245.67.85
Read Community: ipublic

Wwrite Community: g3pd

Swstem Group: Bystems

Send [ Exit

P Start Here &g Applications »

-'E, Programs » f Utilities 3

ﬁ Favorites » g Development »

@ spplets ¢ dy Games 3

m Run z Graphics [3

= Pangl » @ Internet 3

& Lok screen @ Multimedia [3

Lag out * Seftings [3

& system » 1
A Avaya L3 ‘Q Wis&hility Home Page
& Help 5 Fault and Performance Manager »

Administration

L3 ‘t] Add Proxy/MNative Agent to Database Y

Configuring SNMP Traps
Procedure 4: Add a DEFINITY Proxy Agent R4.0

tFPM Report Manager
MFPM Application

E Restore Database
Server Service Configuration

* 1:03 AM
e hMar 25

=10] %]

sktop (vms24:1)

¥ Multivantage Fault and Performance Manager

G2 Kate (Text Editor)
#2 KEdit (Text Editor)
Lo Kivin
& DOD
G2 Kwrite (Text Editor)
E Applications
£ Developrment
& Editors
TR Ganmes
% Programs
2 Graphics
@ Internet
@ Multimedia
o Ofice
©Z Prefarences
& System
#% Toys

»
»
»
»
¥ 4 Applications

Y 2 Development
U 4 Games
:Z Graphics
» @ Intemet
» & Multimedia
» * Settings

& System

J utiities

Contral Center
[Sl Find Files
& Help

ﬁ Haome (Personal Files)

Recent Documents
@ Quick Browser
I8
I Configure Panel
(@) ) Lock Screen
4 @ Lagout

Enter Proxy Agent information:

Proxy Agent:

Read Community:

Wwrite Community:

Systarn Group:

12345,67.09
Ipublic
93pd

Bystems
Send | Exit

(][]

»
>

»
»
3
3
3
3
»
»

=

W Fault and Performance Manager Administration

VisAbility Home Page E} MFPM Application

MFPM Report Manager

[~ 3 root@vms2s:~ - shei - konsais i
X Multivantage Fault and Performance ©

.‘

4 Toverify that thisis fully functional, go to the Fault and Performance Manager application and
run a Refresh Alarmg/Errors from the System Status screen of the node that was just added.
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6 Getting Started

In this chapter you will learn about the following windows and processes:

Creating logins and assigning roles for FPM users

Executing auto discovery on Fault and Performance Manager HP OpenView system
Executing auto discovery on Fault and Performance Manager stand-alone system
Starting the Fault and Performance Manager client from the Linux server

Exiting the Fault and Performance Manager client from the Linux server

Starting the Fault and Performance Manager client from aweb browser

Exiting the Fault and Performance Manager client from aweb browser

NMS maps

Map commands

Online Help system

Creating FPM Logins and Roles

Users must log into FPM before they can use the FPM GUI. You must use Integrated Management
Database (IMD) to

create FPM roles
add FPM users
assign FPM roles to the FPM users

You can set each FPM role to have one or more of the following capabilities:

Administration (Admin)

Allowsthe user to access the FPM Administration menu item for the scheduling of data collection
and reports, system groups, and trunk group lists from the FPM user interface.

BusyoutRelease

Allows the user to Busy/Release boards, trunks, trunk groups, stations, and ports from the FPM
user interface.

Acknowledge
Allows the user to acknowledge alerts within the FPM user interface.
ReadOnly

Allows the user to run the FPM user interface with a read-only permission, where nothing can be
done to voice systems, reports, or scheduling.

CreateReports
Allows the user to
— create new reports that will be stored on the FPM server for future use
— schedule reports to be run automatically in the background by the FPM server
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To create FPM roles and logins, perform the following procedures:

1
2
3

Create FPM roles.
Add FPM users.
Assign FPM roles to the FPM users.

Procedure 1: Create FPM Roles

To create FPM roles, perform the following steps:

1

7
8

Log into Integrated Management Database (IMD), and click FPM Roles in the navigation panel
of the Integrated Management Database Administrator page.

The FPM Roles page appears.

Click Add.

The Add FPM Role page appears.

In the Enter Role Name box, enter the name for the FPM role.

In the Available Capabilities list box, select the capability you want to assign to thisrole. If you
want to assign multiple capabilities to this role, press and hold down the Ctrl key on your
keyboard and click on each capability you want to select.

Click Select.

The selected capabilities appear in the Capabilities assigned to thisrole list box.
Click Add.

A page appears confirming that the role was added successfully.

Click OK.

Repeat Steps 2 through 7 for each FPM role you want to create.

When finished, go to Procedure 2: Add User on page 46.

Procedure 2: Add User

46

Use this procedure to add a user account that can access FPM. If the user was added to I ntegrated
Management Database (IMD) previously, go to Procedure 3: Assign FPM Roles to Users on page 47 to
assign an FPM role to this user.

To add a user, perform the following steps:

1

o O b~ W

Click Usersin the navigation panel of the Integrated Management Database Administrator page.
The Users page appears.

Click New User.

The Add User page appears.

In the Login box, enter the login for the user.

In the User Name box, enter the name of the user.

In the Password box, enter the password for the user’s login.

In the Password box, re-enter the password for the user’s login.
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7
8
9

Getting Started
Creating FPM Logins and Roles

Select the FPM check box.
Click Add.
Repeat Steps 2 through 7 for any other users you want to add.

When finished, go to Procedure 3: Assign FPM Roles to Users on page 47.

Procedure 3: Assign FPM Roles to Users

Use this procedure to assign FPM roles to users. You can assign multiple FPM roles to a user.

NOTE:
Make sure you have created an FPM role already.

To assign an FPM role to a user:

1

Click Usersin the navigation panel of the Integrated Management Database Administrator page.
The Users page appears.

Click Edit for the user to which you want to assign an FPM role.

The Edit User page appears.

Select the FPM check box (if it is not selected already).

The Assign Roleslink appears next to the FPM check box.

Click Assign Roles.

The Assign FPM Roles to a User window appears.

Select the check box of each role you want to assign to this user.

Click Save.

A page appears confirming that the role was updated successfully.

Click OK.

Click Update.

Repeat Steps 2 through 8 for each user to which you want to assign an FPM role.

When you want to exit IMD, click Exit in the navigation panel.
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Starting the Administrative GUI

The Fault and Performance Manager Administrative GUI lets you specify data collection parameters,
create and save report definitions, and schedul e reports. You must start this GUI to perform any of these
tasks.

Procedure

From the FPM server, complete the following procedure:
1 Atthelogin prompt, typeroot and press ENTER.
2 Atthe password prompt, type the root password and press ENTER.
3 Open aterminal window.
The system displays the Linux prompt.
4 Type: cd /opt/avaya/mfpm/bin/ and press ENTER.
5  Execute one of the following scripts to access the information.

— . /MFPMgui - launches Fault and Performance Manager. Add a voice system name at the
end of the command to launch the application for a specific voice system.

— . /PAdiscovery - launches Fault and Performance Manager to add new Proxy Agents.
— ./MFPMgui_RM - launches the Fault and Performance Manager Report Manager.

— . /IMFPMgui_EXxc - launches the Fault and Performance Manager Exception Report for all
Communication Manager Feature Servers registered in Fault and Performance Manager.
Optionally, add the voice system name at the end of the command for the Communication
Manager Feature Server Exception Report for a specific voice system.
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Starting the Fault and Performance Manager
Client from a Web Browser

When you start the Fault and Performance Manager client from aweb browser, you can only view; you
can not make changes. You can start the client from abrowser only if the browser meets the requirements
specified in the Integrated Management Services Support Plan. Contact your client executive for the
reguirements.

Procedure

Complete the procedure below to start the Fault and Performance Manager client from aweb browser.

1  Open asupported browser.
2  Atthe URL address line, typethe | P address for the Linux server where Fault and Performance
Manager isinstalled and press ENTER.
The system displays the Integrated Management home page.
3 Click on Download Products.
The Download Products page appears.
4  Read theinstallation information.
5 Click Download.
A dialog box displays the progress of the download.
6  Click Open.
A dialog box displays vms _client_cdexe file downloading.
The WinZip Self-Extractor dialog box appears.
7  Click Setup to unzip thefile.
The system displays the Avaya Integrated Management Network Management Client for
Windows screen.
8 Click Install Network Management Client Products.
The system indicates that it is preparing the wizard and then displays the Welcome screen.
9  Click Next and follow the prompts.
10 Click Launch Products on the Integrated Management web page.
11  Click Avaya Fault and Performance Manager.
The Java Plugin Security Warning appears.
12  Click Grant this Session.
The FPM Login dialog box appears.
13  Inthe Login Name box, enter your login. (All FPM logins and passwords are administered
through the Integrated Management Database (IMD).)
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14 Inthe Password box, enter your password.
15 Click Login.

The Avaya I ntegrated Management screen displays and Fault and Performance Manager
launches.

Starting the Online Help

50

To start the online help, with Fault and Performance Manager open, choose Help>Help Topics or
Help>Current Panel.

The online help system replaces the user guide for Fault and Performance Manager. The help screens
contain the information listed below:

* Description and purpose of the screen

* Procedure to complete appropriate tasks on the screen

* Linksto Related topics for more information

Help button

A Help button is also available on many tabs, panels, and dialog boxes. Clicking the Help button displays
the help topic for the current screen.
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Exiting the Fault and Performance Manager
Client from a Web Browser

To exit the Fault and Performance Manager client from aweb browser, choose File>Exit.

Fault and Performance Manager Integration with NMS

Before you integrate Fault and Performance Manager with the NM S, you must have installed the Fault
and Performance Manager client on the HP OpenView Windows 2000 server or on Solaris 8.0 or 9.0.
After installing the client, you must run mfpmconfig again to configure the HP OpenView server config
service TCP port number.

Understanding the NMS Maps

The Network Management System Integration (NM SI) is one of the programs in Fault and Performance
Manager, and isintended to integrate Fault and Performance Manager into the HP OpenView network
management application.

This capability does not exist for Linux systems. Linux users execute a Linux command in the command
prompt line to integrate Fault and Performance Manager into their own existing application.

This integration allows you to monitor your Avaya telecommunication elements and data networks from
the same workstation.

NMS maps

NMS| usesthe Auto-Discovery program to find and transmit system data from the managed nodes
(supported systems).

The NMSI uses the data received from Auto-Discovery to create and update the NM S maps, which
include:

* NMS Root map

¢ Avaya Fault and Performance Manager submap

¢ AvayaUSA and state submaps

* Avaya custom submaps

The sections below describe the objects (system icons and connection lines) that display on the map and
the color schemes that indicate the current status of the objects.
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Root Map

52

The root map on the Network Management System (NMS) named “default” istheinitial user interfaceto
the various Avaya submaps mentioned in the previous section.

NMSI places “explodeable” icons representing the various Avaya submaps on the root map. The Avaya
submap icons lead to submaps that contain Proxy Agents and Managed Nodes that have been
administered by the user in FPM.
Theicon names that display on the root map are:

¢ Avaya MAP identifies a Generic submap.

¢ AvayaUSA MAP identifiesthe USA map and associated state submaps.

* Avaya custom submaps will be automatically be defined based on information provided by the
user in Proxy Agent or IMD.

Proxy Agent icon colors

The table below contains Proxy Agent icon colors that display on HP OpenView maps. The colors
indicate whether or not Proxy Agent is responding to requests.

Table 9: Proxy Agent Icon colors

Object HP OpenView Color

Proxy Agent icon Dark Blue = Unknown. Proxy Agent is not
responding
Green = Norma
Cyan = Warning. Proxy Agent isresponding, but is
not honoring SNM P requests. Indicates that the SMNP
community string for the NM S is incorrect.

Red = Magjor. Proxy Agent failed to forward an alarm
to INADS onitslast try.

Fault and Performance Manager icon colors

Fault and Performance Manager maintains alist of active exceptions for the systems listed bel ow:
¢ Communication Manager Feature Server
¢ Multipoint Conferencing Unit (MCU)
¢ Adjuncts and voice messaging systems

Fault and Performance Manager treats the MCUs as Communication Manager Feature Servers.

The table below contains the Communication Manager Feature Server icon colors and Proxy Agent line
connections that display on the Fault and Performance Manager maps.
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Table 10: Communication Manager Server icon colors

Object

HP OpenView Color

Communication
Manager Feature Server
icon

Line connections to
Communication
Manager Feature Server
icons

Dark Blue = Unknown. Proxy Agent is not
responding

Green = Normal

Cyan = Warning

Yellow = Minor

Orange = Major

Red = Critica

Black = Up

Red = Down or Other

Yellow = Init (initiating)

Cyan = Off

Salmon = |dle for dynamic connection

Other system icon colors

The NMSI only supports alarm traps from Proxy Agent for the systems below:
¢ DEFINITY AUDIX releases 3.1 through 4.0
* Intuity AUDIX release 5.1 (with or without the remote maintenance board)

* Intuity Interchange release 5.1 through 5.4

¢ Call Management System (CMS) R3V 8.3 through R3V11

* CONVERSANT release 7.0 through 9.0

* |A770INTUITY AUDIX Release 1.0

* SB8100 Media Server INTUITY AUDIX

e |A770INTUITY AUDIX® Option for S8300 ICC Release 1.0 through 2.0
¢ INTUITY™ AUDIX® on S8100 Media Server

e INTUITY™ AUDIX® LX Release 1.0 through 17.X

* INTUITY™ AUDIX® on Multimedia Messaging Platform Release 1.0 through 1.1
¢ Converged Communications Server (CCS) Release 1.0.

* Interactive Response (IR) Releases 1.0 through 1.2

The Fault and Performance Manager maps provide only telnet support to the products above.

The table below contains the other system icon colors and Proxy Agent line connections that display on
the Fault and Performance Manager maps.
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Table 11: Other system icon colors

Object HP OpenView Color

Other system iconsfor; Dark Blue = Unknown. Proxy Agent is not
DEFINITY AUDIX responding

Intuity AUDIX Green = Normal

Interchange Cyan = Warning

CMS Yellow = Minor

CONVERSANT Orange = Mgor

Line connectionsto other  Black = Up. Proxy Agent isrunning and
systemicons available to receive alarm traps.

Red = Proxy Agent is stopped and cannot
receive alarm traps.

Executing Auto-Discovery

54

This section isfor NM S| Fault and Performance Manager systems only.

Auto-Discovery is afeature of your NMS that automatically gathers information about the managed
nodes (voice elements) in your telecommunications system, and presents that information graphically
using icons and maps.

To execute Auto-Discovery:
From the HP OpenView server, click Avaya>System View>Rediscover Entire M ap.
NOTE:
It will take some time for any new managed nodes to be discovered by FPM and

configuration data collection to take place. Only then will there be meaningful information
on the NM S maps for these nodes.
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Executing Commands from NMS Maps

The NMS Integration (NMSI) program allows users to execute various commands from any of the NMS
maps. Most of the commands perform operations on the systems that display on the selected map.

Users can execute the commands in two ways:
* Select acommand from amenu

* Right-click the mouse on the symbol/icon, and select the appropriate command from the popup
menu

Some of the Avaya commands and applications are not available on a Solaris server.

The sections below explain the commands and the execution options.

Description of Commands

The table below lists the commands that users can execute from any NMS map. The Description column
describes the result of the command.

Depending on which NMSI command is selected and run, icons on the NM S maps can change status, be
added or removed from the map, etc.

MultiSite Administration, Avaya Site Administration, Voice Announcement Manager, Avaya Terminal
Configuration, VMON, Proxy Status, Proxy Cache Status, Proxy Incoming AlarmLog, Fault
Performance Manager, FPM Report Manager, FPM Exception Report, Telnet to Managed Node, Telnet to
Proxy Agent, FPM Sever Status, FPM Server Collection Status, Integrated Management Web Page, and
Communication Manager Web Page applications and commands can a so be launched from the HPOV
default map, Avaya menu.

Table 12: NMS Map commands

Command Description

Fault and This command displays the main window, which contains the
Performance systems group navigation tree and configuration and status window.
Manager

If you execute this command for a specific Communication Manager
Feature Server on the NM'S map, then the command opens the main
window with focus on the selected Communication Manager
Feature Server.

FPM Report This command displays the Report Manager window of the Fault
Manager and Performance Manager.

FPM Exception  This command displays the results of a Fault and Performance
Report Manager Exception report.

Y ou can only execute this command for a specific Communication
Manager Feature Server on the map. The report shows exceptions
only for the selected Communication Manager Feature Server.

1o0f3
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Table 12: NMS Map commands

Command

Description

Rediscover
Entire Map

Re-register
with Server

The Rediscover Entire Map process is primarily driven by the Fault
and Performance Manager database and collection process. The
database is used because not all Avaya products that Fault and
Performance Manager deals with are | P based. Therefore, the
Rediscover Entire Map process will place icons on one of the
submaps and show connectivity between that device and others
without regard to whether HP OpenView can discover that device.
This command may run automatically on start-up of any HPOV
console window.

During the Rediscover Entire Map process, the text message
“synchronizing” is shown at the bottom left of the HP OpenView
GUI. (Thisisalso true for other System View commands.) At the
end of the Rediscover Entire Map process, this text message
disappears to denote that the command has completed. The time
needed to perform a Rediscover Entire Map depends primarily on
the size of your network. For the Rediscover Entire Map command
to run, the following conditions must be met:

* The FPM server must be operational.
¢ HP OpenView must have a Read-Write map open.

* A connection must be established between HP Open View
and the Fault and Performance Manager server process,
NmsiServer.

If any R/O maps are displayed when a Rediscover Entire Map is
requested from the R/W map, the R/O maps will not be immediately
updated. The user must do a Map> Refresh from each R/O map to
bring it into sync with the R/W map. Doing the M ap>Refresh will
close any open R/O submaps and take the user to the top level of that
R/O map. The only exception to thisrule is with regard to status
updates which are doneimmediately across al maps and do not
require the manual refresh.

The Re-register with Server establishes a connection between the
Fault and Performance Manager server and HP OpenView. A Re-
register with Server is done automatically when the HP OpenView
GUI is started. The NM S| code always attempts to keep its Avaya
maps of Managed Nodes synchronized with the data received from
FPM. The NMSI code automatically adds Managed Nodes to its
maps when it receives status for newly added nodes from FPM.

You can run the Re-register with Server command even if a session
already exists; this does not cause problems. In fact, running the Re-
register with Server command is the simplest way to verify that a
connection exists between HP OpenView and the Fault and
Performance Manager server. If aconnection cannot be established,
an error message pops up on the screen.
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Table 12: NMS Map commands

Command Description

Cleanup DB The Cleanup DB command removes objects created by the Refresh
Entire Map command, as long as the object has no associated
symbol.

TelnettoProxy  This command displays the telnet window to Proxy Agent.

Agent From the telnet window, users can log in to Proxy Agent and initiate
an emulation session to cut-through to the managed node.

Telnet to This command is for |P-connected nodes. Users can telnet directly

Managed Node  to the node rather than going through Proxy Agent.

Update System  This command retrieves and updates the current status of the

View Status Managed Nodes in the NMS. This command may run automatically
on start-up of any HPOV console window.

Update For each Voice System and/or Adjunct that is selected on the NMS

Managed Node  map, this command retrieves and updates the current status of the

Status Voice System/Adjunct. Y ou can select one or more voice systems/
adjuncts with this command.

Proxy Status This command retrieves and updates the current status of proxy
agents.

Proxy Cache This command retrieves and updates the current status of the cache

Status for proxy agents.

Proxy This command retrieves and updates the current status of incoming

Incoming alarmsfor proxy agents.

Alarm

FPM Server This command retrieves and updates the current status of the FPM

Status server.

FPM Server This command retrieves and updates the current status of FPM

Collection collection activities.

Status

Integrated This command displays the I ntegrated Management home page.

Management

Web Page

Communica- This command displays the Communication Manager home page.

tion Manager

Web Page

30f3
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Exiting the Fault and Performance Manager
Client from the Linux Server

Clicking the “X” box in the upper right corner results in unpredictable behavior. To exit the application,
follow the steps below:

1 Toexit Fault and Performance Manager, from the menu bar on any screen, click File > Exit.
The system exits the product and displays the Root map.

2 Tolog off the NMS, click Map > Exit.
The system displays the Linux login prompt.
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Glossary and Abbreviations

A

ATAC
See Avaya Technology and Consulting (ATAC) on page 13.

Communication Manager
The call processing software that runs on Communication Manager Feature Servers. Formerly known
as DEFINITY software.

Communication Manager Feature Server
Any of the products that run Communication Manager. Formerly known as DEFINITY system,
DEFINITY ECS, switch, PBX, or voice system.

managed node
In this document, a managed node is any system (voice system or otherwise) that can be viewed and
monitored using Fault and Performance Manager and Proxy Agent.

Network Management Server
Thisisthe Windows or Solaris box that you can install Integrated Management applications on.

Network Management System
A system that lets you monitor the health and status of devices on your data network. For example,
HP OpenView.

RNIS
See Avaya Remote Network | ntegration Services (RNIS) on page 13.

supported systems
In this document, a “ supported system” is any of the voice systems or adjuncts that Proxy Agent
works with. See Supported Systems on page 18.

SNMP
Simple Network Management Protocol.

System Management Server
Thisisthe Linux box that you install Fault and Performance Manager or Proxy Agent on.
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TSO
See Avaya Technical Service Organization (TSO) on page 13.
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giving feedback on, 10
on the web, 10
ordering, 11
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commands, 28

system health, 28
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third party, 15
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backup, 29
restoring, 29
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introduction, 56
documentation
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on the web, 10
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editing system files, 30
Enterprise Management Support, 14

F

feedback, giving us your, 10

H

Hewlett-Packard web site, 15
HP OpenView, integrating FP Mgr with, 21

installation

services, 13
Integrated Management Services Support Plan, 15
integrating FP Mgr with HPOV, 21

M

Microsoft web site, 15

N

network
security, 16

Network Management System (NMS)
integration process, 51

O

OpenView, integrating FP Mgr with, 21

= |
ordering, 11
P
passwords, changing, 16
PostgreS web site, 15
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Red Hat web site, 15
Remedy web site, 15
requirements, 19
restore database, 29
RNIS, 13
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security

Avaya disclaimer, 16

for networks, 16

network, 16

notices, 16

toll fraud, 16

toll fraud intervention, 16
Services Support Plan, Integrated Management, 15
stand-alone configuration, 24
system commands, 28
system files, editing, 30
system health, 28
system requirements, 19
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Technical Service Organization, 13
Technical Services Organization, 13
toll fraud, 16

Avaya disclaimer, 16

intervention, 16
Toll Fraud Intervention phone number, 14
TSO, 13
typographical conventions, 9
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Vytek web site, 15
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web sites
Avaya, 14
third-party, 15
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